
MergeFax 2.1 for WinFax PRO
User’s Guide

                        

What is MergeFax?

MergeFax 2.1 is an add-on program that allows you to "mail-merge" group fax 
THOUSANDS of PERSONALIZED faxes with Word for Windows 6.0 and WinFax PRO 
3.0, 4.0, and WinFax PRO for Networks.

Quickly "touch" all of your customers—locally and world-wide—with the stroke of a 
single key. On a 486-66 machine, MergeFax queues up WinFax PRO's Out Box with 
100 faxes in 5 minutes!

Send price lists, special offers, or new product announcements to all your customers. 
Send sales and marketing information to your distribution and sales staff. Send press 
releases, newsletters, event announcements, itineraries, investment updates, etc.—
each one personally written to each individual.

MergeFax is far more effective than sending "junk mail" and "broadcast faxes" because
people receive PERSONALIZED messages, INDIVIDUALIZED communications—with 
detailed information so fine, so specific, you are only limited by your "data source" and 
your use of Word 6.0's powerful mail merge features.

Here's how it works:



1. MergeFax automatically merges each data record, scans the document to find the 
recipient’s name and fax number, and then (using DDE) passes them over to 
WinFax PRO.

2. MergeFax queues up all the faxes in WinFax PRO's Out Box—either to be sent 
immediately or scheduled for a later date and time.

3. MergeFax automatically sets the fax driver and resets the printer driver for you—so
you don’t have to fiddle with driver settings. You just run MergeFax, and it 
automatically switches to the fax driver, merges each data record, scans each 
merged document to find the recipient’s name and fax number, passes them 
over to WinFax PRO, queues up all the faxes in WinFax's Out Box with their 
pending date and times, and finally returns you back to Word for Windows after 
resetting your printer driver back to whichever default printer it was on.

4. MergeFax does all this in minutes! For example, on a 486-66 machine, MergeFax 
queues up WinFax PRO's "event list" with 100 faxes in 5 minutes!

5. It's as easy as these 2 steps:

1. Set up your mail-merge main document.
2. Hit Alt-M and START.

Installation and Setup

To setup MergeFax, DOUBLE CLICK the "install button." The MergeFax
Setup dialog box will appear. You can then pick the default settings of 
your choice, and create your own custom identifiers.

Note: This setup is made to be run again and again, anytime you wish to choose 
different default settings or re-design your own custom identifiers.

Note also: If you decide after trying MergeFax 2.1 that it's not for you, you can easily 
remove it from your system by following the instructions in Appendix A: Un-Installing 
MergeFax 2.1 (at the end of this guide).

This is what the install macro does:
· It copies the MergeFax macro into your NORMAL.DOT template so that it will be

available globally.
· It assigns the keyboard shortcut key of Alt-M to the MergeFax macro.
· It adds MergeFax to the menu of your choice.

Note: If you get an error when you first try to run MergeFax, it usually means that the 
directory in which you installed WinFax PRO (usually C:\WINFAX) is not in your path 
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statement in your autoexec.bat file. For WinFax to function properly with DDE, WinFax 
must be either in your path statement or running when the DDE is initiated. If C:\
WINFAX is not in your PATH statement in your autoexec.bat file, simply add it and 
reboot your computer.

Important: For MergeFax to install properly, all three files (MERGEFAX.DOC, 
MERGEFAX.DOT, and MERGEFAX.BMP) must be in the same directory (for example 
C:\MERGEFAX). This is because the install macro looks for MERGEFAX.DOT and 
MERGEFAX.BMP in the same directory that you open MERGEFAX.DOC.

We recommend you create a directory called C:\MERGEFAX to store all the MergeFax 
files. This way you can re-run the Install MergeFax macro any time in the future should 
you decide to change any of the defaults or re-design your own custom identifiers.

That's it! Once installed, you can begin using MergeFax immediately. To see how it 
works, see the Sample.doc section below.

Sample.doc

To see a demonstration of MergeFax 2.1 in action, we have included a sample mail-
merge "main" document (SAMPLE.DOC) attached to a sample "data source" 
(SAMPDATA.TXT) that contains 5 records.

Simply open SAMPLE.DOC and hit Alt-M and Start. That's it! MergeFax will 
automatically switch to the fax driver, merge each data record, scan each merged 
document to find the recipient’s name and fax number, pass them over to WinFax PRO,
queue up all the faxes in WinFax's Out Box with their pending date and times, and 
finally return you back to Word for Windows after resetting your printer driver back to 
whichever default printer it was on.

Open SAMPLE.DOC and check it out!

Understanding "Data Sources"

If you are unfamiliar with the term "Data Source," this is just the general term used to 
describe a database or any other repository of information — such as names, 
addresses, and fax numbers — which can then be used to PERSONALIZE a form letter
or INDIVIDUALIZE any other kind of merge document.

If this concept is new to you, and you're thinking, "I don't have any data sources," in 
fact, you most likely do. There are many kinds of programs you can use directly, or 
indirectly, as data sources:

1. Database Programs such as Microsoft Access, Paradox, FoxPro, dBASE, etc.
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2. PIMs and Contact Manager Software such as ECCO, Organizer, Commence, 
ACT!, etc.

3. The WinFax PRO "phonebook" itself is a data source! Not many people know 
you can use this as a data source to send personalized merge faxes, but 
you can. Just attach the file DEFAULT.DBF (usually found in your C:\
WINFAX\DATA directory) to your mail-merge main document, and you will 
be able to create personalized merge faxes that contain each person's 
name, address, fax number, etc.—automatically filled in!

4. You can even create a new data source with just Word for Windows 6.0. Word 
6.0 has a "Database toolbar" that allows you to easily add, delete, search, and 
sort data fields. And you could use this simple database to keep all of your 
contact names, addresses, and phone numbers.

For more information on this 4th option, see the Word 6.0 User's Guide chapter 29 "Creating a 
New Data Source" (pages 642-645).

Some of these data sources — such as Microsoft Access for example — can be 
"linked" or "attached" directly to your mail-merge main document. Others require the 
extra step of exporting your data into a format that Word 6.0 can read.

For example, the sample data source included in the MergeFax package 
(SAMPDATA.TXT) is in the form of a "comma field delimited text file." Most PIMs and 
Contact Manager software allow you to export your data into this format so that Word 
6.0 can read it.

For more information on Data Sources, see the Word 6.0 User's Guide chapter 30 "Using a Data Source 
from Another Application" (pages 676-679) and "Planning and Organizing a Data Source" (pages 680-
685).

MergeFax Identifiers: “To:” & “Fax:” or Whatever you want!

MergeFax searches for “To:” and “Fax:” (or any custom identifiers you create) to 
identify the recipient’s name and fax number.

MergeFax allows you to create any custom identifiers you wish! For example, if you 
prefer “Fax #:”, or “Fax No.:”, or “Fax Number:”, etc., simply re-run the MergeFax 
Installation to make the identifiers anything you want.

Because MergeFax scans the entire document, the “To:” and “Fax:” information can be 
anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a
one page letter, they will be on that. But the nice thing about MergeFax is that they 
don’t have to be. They can be anywhere. And in any order.

For example, they can be on the same line, like this:

To: Woody Allen Fax: 555-555-5555
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Or they can be reversed, like this:

Fax: 555-555-5555 To: Woody Allen

Or they can be separated by tabs, like this:

To: Woody Allen
Fax: 555-555-5555

Or they can have leading text on the same line, like this:

This message To: Woody Allen

Or they can have following text on the same line (as long as there is a tab or at least 
two spaces after the name or fax number), like this:

To: Woody Allen  Date: January 20, 1995

In fact, MergeFax's search routines are so smart, they will even work with everything 
crammed together on one line, like this:

To:Woody AllenFax:555-555-5555

Note: MergeFax always goes to the top of the document and searches down. So, 
if there is more than one identical identifier in a document, it always finds the first one.

The Big Tip: "Hidden Identifiers"

MergeFax's ability to find "hidden identifiers" gives you complete flexibility in designing 
your faxes to look exactly the way you want, while at the same time allowing MergeFax 
to find the recipient's name and fax number accurately. To understand how this works, 
please see the following 3 examples:

Example 1: Hiding the "To:" and/or "Fax:"

If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden
identifiers” by selecting them and choosing Format>Font>Hidden text. MergeFax will 
still find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your
fax.

For example, you might want to fax a one page letter containing the recipient’s name, 
address, and fax number—but in this case, you wouldn’t want the word “To:” to show 
up. Simply do it like this:

BONZI Software
396 17th St.
Paso Robles, CA  93446
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Fax: 805-238-5798

Dear BONZI Software,

I love MergeFax! Great work! Kudos!

(Note: there is a hidden “To:” before the name BONZI Software. If you cannot see this,
hit Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and 
know it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when
you print and/or fax. Note: If it does show up, your printer options are probably set to 
"Include Hidden Text with Document" under Tools>Options>Print. Simply uncheck this 
setting to achieve the results you want.)

Example 2: Using Separate Cells

If you split “To:” and "Woody Allen" into separate cells, MergeFax has no way of 
knowing they are related.

To: Woody Allen

But not to worry! If you prefer this two-cell method, you can easily make it work with 
hidden identifiers! One method is to custom design a name identifier (into anything 
different than "To:". For example, "To>"). Then simply add that "To>" as a hidden 
identifier. Like this:

To:  Woody Allen

MergeFax will search for "To>" and find Woody Allen!

If you use this method often, we recommend that you store the hidden identifiers "To>" 
and "Fax>" in Word's AutoCorrect (with "formatted text"). Then all you have to do is hit 
"t" space, and AutoCorrect will replace the "t" with the hidden "To>".

Or, here's an even better idea! Just put the hidden identifiers in your fax templates. 
Then, every new fax document you create will already have them typed in.

Example 3: Skipping over YOUR fax number

If you have a header with YOUR fax number in it, you will want MergeFax to skip over 
your fax number and find the recipient’s fax number. You could simply make your fax 
number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want
to use the same identifier for both your fax number and the recipient’s fax number, you 
can simply use a hidden identifier (like "Fax>"). Example:

ABC Widget Co.
1225 Main St., Paso Robles, CA  93446

Phone: (805) 222-2222  Fax: (805) 444-4444
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To: So-and-so.
Fax:  555-555-5555

Dear So-and-so,

I love your widgets! Great work! Kudos!

However, an even better method is to add a hidden space between "Fax" and the ":" in 
your letterhead. MergeFax will then skip over your fax number and find the recipient's 
fax number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax 
number identifier will look like this: "Fax :". But that hidden space won't print, so on the 
fax, it will look like this: "Fax:". An example of this method is used in the file 
SAMPLE.DOC.

So you see, with MergeFax 2.1, you have complete flexibility in designing your faxes to 
look exactly the way you want, while at the same time allowing MergeFax to find the 
recipient's name and fax number accurately. And if you prefer, you can even completely
hide the "hidden identifiers" by hitting Tools>Options>View>Hidden Text. This turns off 
the "Show Hidden Text" feature. So you'll never even have to see them on the screen. 
But MergeFax will find them, and pass the necessary information over to WinFax PRO.

Date and Time Scheduling

MergeFax allows you to send your faxes immediately or schedule them for a later date 
and time.

When you choose "Now", MergeFax queues up the faxes in WinFax PRO's Out Box at 
the same time that WinFax PRO is sending them in the background. When you choose 
"Scheduled", you can set the faxes for any future date and time. This is especially 
useful for taking advantage of the cheaper phone rates late at night.

Note: When you schedule, remember that WinFax PRO only accepts date and time in the following 
formats: Date: MM/DD/YY. Time: HH:MM:SS. This is not hard to remember, as MergeFax displays the 
correct formats for you in the date and time fields. Notice, too, that MergeFax always defaults to today's 
date at 11:00pm that night. This is because the lowest phone rates occur in most places between 
11:00pm - 8:00am.

Some people like to run MergeFax with the "Now" setting and walk away from their 
computers. This method works fine, but there are some advantages to "scheduling" the 
transmission time for a later date and time — even if it's only to queue up all the faxes 
in WinFax PRO's Out Box before letting them go:

Advantages of Scheduling:

1. The biggest advantage is you can double-check your faxes before sending 
them out by using WinFax PRO's viewer to look at the actual graphical 
images of each fax. This is the best place to double-check your faxes to 
make sure your data and document have merged correctly, because you 
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see EXACTLY what is going to print out on the recipient's fax machine 
before you send it off. Once you're satisfied with the look and layout of your 
faxes, you can either immediately send them all off (by selecting them, 
hitting WinFax PRO's "Reschedule" button, and choosing "Now") or you can
"Reschedule" them for the best future time.

2. Another advantage of scheduling is you can cancel or delete any faxes that 
have merged incorrectly because of incomplete data or incorrect merge 
fields.

3. Another advantage of scheduling is, as we said above, you can take advantage
of lower telephone rates outside of peak hours.

4. Another advantage is that if a problem occurs halfway through the fax merge, 
you won't have to determine and filter out those people who have already 
received their faxes, and those who haven't.

5. And the last advantage is that when you have queued up all the faxes in 
WinFax PRO's Out Box, you can confidently walk out for the night because 
WinFax PRO will handle all of the transmitting and logging — so that when you 
come back in the morning, you'll be able to quickly see any faxes that didn't 
correctly reach their destination and why: Busy signal, no fax machine 
response, etc.

Important Note to Intel CAS software users: When scheduling faxes, be aware that an incompatibility 
appears to exist between WinFax PRO and Intel CAS software. If you schedule a fax for a later date or 
time, and then delete the pending fax from the WinFax Event List or the WinFax OutBox, the .DCX file 
that the Intel CAS software creates is NOT deleted by either Delrina or Intel. So you must go to the 
directory in which the .DCX file is stored (usually c:\winfax\data) and delete it manually.

High Volume MergeFax-ing

To maintain maximum system memory during high volume MergeFax-ing, MergeFax 
periodically pauses to allow WinFax PRO to finish processing the faxes it is holding in 
memory.

To determine the best settings for high volume MergeFax-ing, take into consideration 
the following:

1. The version of WinFax PRO you are using — because WinFax PRO 4.0 
processes much more up-front than WinFax PRO 3.0 does. This makes 
3.0's perceived speed faster than 4.0's (because it goes onto the next 
fax more quickly by storing more unfinished work in memory), when in 
fact their actual speeds are about the same (if anything, 4.0 is a little 
faster). But the point here is this: WinFax PRO 4.0 does much more 
foreground processing — which means it doesn't need as long a "wait 
time" to process unfinished faxes in memory. WinFax PRO 3.0 does 
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much more background processing — which means you'll want to set 
longer "wait times" to allow for this.

2. The size (page length) and graphical "weight" of each fax — because 
longer and more graphically intense faxes take longer to process than 
short 1-page letters containing no graphics.

3. The total volume you will be sending — because it takes progressively 
longer to process and index each fax in the WinFax Outbox as the 
volume climbs into the thousands.

4. The amount of system resources you have (RAM and virtual memory) 
— because the more you have, the more unfinished faxes WinFax PRO can
hold in memory.

For example, for volumes of 1 to 500 single page faxes, we recommend the following 
settings (on a 486-66 with 16 Megs of RAM and 20 Megs of virtual memory).

· Using WinFax PRO 3.0: Every 10 faxes, wait 30 secs.

· Using WinFax PRO 4.0: Every 25 faxes, wait 10 secs (the default).

You'll want to increase the wait time as your volume increases into the thousands. And 
the nice thing about MergeFax 2.1 is that it gives you complete control to "tune it" for 
your unique system.

Note: These settings cannot be changed in the middle of a MergeFax session — i.e. 
once MergeFax is running. So, if you think you'll need to change these high volume 
settings, be sure to "tune it" before hitting the "start" button.

Note, also: If you encounter an "out of memory" message during a high volume 
MergeFax, it is because Word 6.0 and WinFax PRO have run out of room to process 
anymore faxes. Make sure you close all unnecessary applications when MergeFax-ing 
to give Word 6.0 and WinFax PRO maximum space to work in. It's important to keep 
your resources to a maximum because, as Microsoft explains:

Even though a computer may have a large amount of memory (either RAM or 
virtual memory), the computer may still run out of resources. This is because 
Windows 3.1 and Windows for Workgroups allocate a subset of the total memory 
for system operations, and each application consumes a portion of this memory 
subset. When multiple applications are running, the memory used for system 
operations may be entirely consumed, causing Windows to display an "out of 
memory" message, even though there is plenty of available RAM. Windows NT, 
however, does not have this limitation.

If after closing all other applications, you still encounter "out of memory," you may need 
to close out of Windows and come back in fresh to free up your system's resources. 
This is because many applications do not release system resources when you close 
them. And so, if you have opened and closed many applications throughout the 
workday, you will not have as much memory available as when you first came into 
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Windows fresh. This is why it's a good idea to periodically close out of windows and 
come back in fresh. You'll regain any lost resources.

If that doesn't do it, and you still encounter "out of memory," it most likely means you 
are running some other program that "leaks" resources. MergeFax does not leak 
resources at all. We have tested MergeFax by processing 2,010 faxes. The system 
resources did not drop a single percent throughout the entire process. In fact, 
MergeFax's only limitation is your available hard disk space (for storing all the faxes).

You can check your "system resources" with a program like Norton Utilities' "System 
Watch" or viewing the Help>About Program Manager screen. If your system resources 
continually decrease when running MergeFax, then some other program is causing 
them to "leak." Ironically, it has been reported that two "system resource monitoring 
programs" leak resources with WinFax PRO 4.0. They are SYSMETER and 
SMARTMON.

Checking to make sure data is merging correctly

There are two ways to confirm that your data is merging correctly.

1. BEFORE you run MergeFax. With the "View Merged Data" button on, you can
click the "Next Record" (red arrow >) button to jump from record to record 
and see how each record is merging with the document. You'll know 
immediately if there are any changes you need to make to your data source 
before running MergeFax. (Or, you could also merge to a temporary 
document and browse it).

2. AFTER you run MergeFax. With all the faxes scheduled and queued up in the 
WinFax event list, you can view and peruse the graphical fax pages to make 
sure they were merged properly. What you see at this point is exactly what will 
be sent, so you can be confident in the knowledge that everything is "perfect" 
before sending them out.

Data merges correctly because of 1) complete data and 2) correct merge fields. 
Whenever you find incomplete data in your data source—for example, a blank fax 
number field—the most effective method is to correct it immediately so that you will 
never have to deal with that record again.

Note: Earlier versions of MergeFax received the "WinFax PRO DDE Error: No Fax 
Number Supplied" if any of your records contained a blank fax number. Users quickly 
learned to "query out" all of their records containing no fax numbers—as this DDE Error
would halt the MergeFax-ing process.

MergeFax 2.1 now quickly checks each fax number before passing it over to WinFax 
PRO, and if it finds a blank fax number, it replaces it with the phone number 555-5555. 
This insures that the MergeFax-ing process will no longer be halted by the "No Fax 
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Number Supplied" error. And it makes it easy to spot any of these empty fax number 
fields in your database.

You can either scan your WinFax PRO Out Box for 555-5555 before sending the faxes 
out, or you can send them all out and let WinFax PRO log any that were not completed 
successfully. Because 555-5555 is a non-existent number (that's why you see it used a 
lot in television and movies), your send log will show and X-mark next to each one that 
could not be delivered successfully.

Dialing Prefixes

MergeFax handles all of the following dialing prefixes automatically:

· Outside line access codes (for example "9")
· Local area codes
· Long distance access codes
· Local long-distance access codes
· 800 prefix access codes

You'll appreciate how MergeFax adds the necessary prefixes and access codes to your
fax numbers so you don't have to worry about them or waste time adding them by 
hand.

Outside line access codes

If you need to dial a prefix to get an outside line (for example "9"), MergeFax will 
automatically add this prefix before each fax number. You can also include commas for 
necessary delays (each comma = 2 second delay).

Note: MergeFax will ALWAYS add the default dialing prefix to EVERY fax number. If you don't use a 
default dialing prefix, leave this option blank in the MergeFax setup.

Local area code

MergeFax automatically recognizes your local area code and avoids dialing it. If you 
travel, move, or your local area code changes for any other reason, simply enter your 
new area code in the MergeFax installation program, and MergeFax will take care of 
the rest.

Note: The following dialing prefixes (Local area code, Long distance access code, Local long-distance 
access codes, and 800 prefix access code) may not work in some countries because of non-standard 
number lengths. MergeFax looks for 7 digit numbers (for example 238-5798) and 10 digit numbers (for 
example 805-238-5798) to determine when local and long distance access codes need to be added.

MergeFax only tests numbers that are 7 or 10 digits long, ignoring all others. To do this, it first strips out 
all "non-number" characters and symbols, then re-formats the numbers into the North American standard 
(i.e. 3 digit area code followed by 7 digit number), adding the dashes "-" in between them.
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In other words, MergeFax must assume that a 7 or 10 digit number falls into the North American 
standard. If you live in Europe, or you dial many 7 and 10 digit numbers that do not fall into the North 
American standard (i.e. 3 digit area code followed by 7 digit number), you can leave the local area code 
blank in your MergeFax setup to prevent MergeFax from testing and re-formatting your 7 and 10 digit 
numbers. Then see "Not supported: International access and local country codes" below to learn how to 
set the default cursor location in the "fax number field" so you can quickly enter any necessary numbers 
before faxing.

Long distance access code

MergeFax will add a long distance dialing prefix to numbers outside of your local area 
code (usually a "1"). Note: The telephone companies are now in the process of 
eliminating these long distance access codes. When this change occurs in your area, 
simply re-run the MergeFax installation program and remove the long distance prefix.

Local long-distance access codes

MergeFax will add a dialing prefix to numbers WITHIN your local area code that require
a long distance access code (usually "1"). Sometimes referred to as "toll calls," 
MergeFax automatically handles all of these local long distance numbers. Note: The 
telephone companies are in the process of eliminating these codes, also.

During the MergeFax Installation, you are asked to list all of the "LOCAL TOLL FREE 
PREFIXES" in your area code that you can call without a long distance access code. 
Separate each prefix with a comma. Ex: 238,239,466,etc.

Tip: You will usually find a list of these numbers in the first few pages of your local 
phonebook. It's usually under a section titled "Local Calling" or the like. And it usually 
says something like this: "If the first three digits of the telephone number you are calling
from are: 227,237,238,239,434, you may call telephone numbers beginning with the 
first three digits listed below at the local rate by dialing the seven digit number."

Note: You do not have to use this feature, or any of the dialing prefix features, if your data already 
contains all of the correct dialing prefixes and access codes needed for dialing. MergeFax simply offers 
you these dialing prefix and access codes as an option to find the quickest and easiest method to send 
thousands of merge faxes.

800 prefix access code

MergeFax will also automatically add the dialing prefix required for 800 numbers 
(usually "1").

Not supported: International access and local country codes

Note: International access codes and local country codes are not supported by 
MergeFax at this time. However, these codes can be handled by using either of the 
following two methods:

1) Simply include the codes needed for each fax number in your database. 
This is probably the simplest method, unless you already have a very 
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large database that does not contain the proper dialing codes. In that 
case, you can —

2) Create a query that filters out all international numbers and then send them 
as a batch. For example, to dial the prefix "011" before every phone 
number, simply add it to your main mail-merge document before the fax 
number field like this:

Fax: 011<<Fax Number>>

Tip: Just as hidden text works nicely for hidden identifiers, the same principle can be 
applied to numbers, or even text, that you need to pass to WinFax PRO, but that you 
don't want to show up on the fax. For example:

 Fax: 805-238-5798

You won't see the international code "011" on the fax, but MergeFax will find it, enter it 
in the fax number field, and pass it over to WinFax PRO for dialing. (Note: You can 
even include comma delays if needed.)

Suggestions

Read chapter 29 ("Mail Merge: Step by Step") in Word 6.0 User's Guide

If you already know how to mail merge, there is nothing more for you to learn to run 
MergeFax because MergeFax simply takes advantage of Word for Windows 6.0's 
awesome mail-merge features.

If you don't know how to mail merge, you'll need to learn how to set up a mail merge 
"main" document and attach a data source to it, etc. All this information is explained 
clearly in chapter 29 of the Word for Windows 6.0 User's Guide. Don't be intimidated. 
Word for Windows 6.0 has the simplest mail merge setup we've ever seen. You'll be up 
and rolling in no time.

Loading WinFax PRO

The most efficient way to use WinFax PRO and MergeFax is to have WinFax PRO 
already loaded, because this way, when you run MergeFax, it will pop right up. But 
even if WinFax PRO is not already loaded, it's no big deal. It only adds one more 
keystroke.

When you run MergeFax without WinFax PRO already loaded, the following message 
appears: “The remote data (TRANSMIT) is not accessible. Do you want to start the 
application FAXMNG?” FAXMNG is the main WinFax PRO program (it stands for “Fax 
Manager”). This message is Delrina's way of saying, "Do you want to load WinFax 
PRO?" So simply hit "Yes"—it will quickly load WinFax PRO—and MergeFax will take it 
from there.

13



Note: If you get an error when answering "yes" to "Do you want to start the application 
FAXMNG?", it usually means that the directory in which you installed WinFax PRO 
(usually C:\WINFAX) is not in your path statement in your autoexec.bat file. For WinFax
PRO to function properly with DDE, WinFax must be either in your path statement or 
running when the DDE is initiated.

WinFax PRO's Preview/Annotate feature

Note: We've found that MergeFax does not work with WinFax PRO's 
"Preview/Annotate" feature turned on. We have encountered strange behavior—
sometimes even General Protection Faults—by running MergeFax with 
Preview/Annotate turned on. For some reason WinFax PRO cannot handle it. So we 
recommend you turn off "Preview/Annotate" before running MergeFax.

Assigning MergeFax to a toolbar button

If you’re a toolbar person, assign MergeFax to a toolbar button. The only reason we 
didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t 
have any more room to add toolbar buttons.

There is no MergeFax icon. But you can choose any of the custom buttons that come 
with Word 6.0. Just click tools>customize>toolbars>macros and drag and drop the 
MergeFax macro to your toolbar. Then choose one of the custom buttons, or create a 
"Text Button," which will say MergeFax.

Upgrade from WinFax Lite to WinFax PRO 3.0, 4.0 (or WinFax PRO for 
Networks)

MergeFax does not work with Delrina's WinFax Lite because WinFax Lite does not 
support DDE like WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) does. 
Therefore, with WinFax Lite, MergeFax has nothing to "pass" the information to. If 
Delrina ever upgrades WinFax Lite to include DDE support, then MergeFax should 
work with it also. But until they do, only WinFax PRO 3.0, 4.0, and Networks users can 
take advantage of MergeFax's dynamic data exchange.

Print out this MergeFax 2.1 User's Guide

We've put everything we could think of into this MergeFax 2.1 User's Guide. All of the 
most common questions and answers, problems and solutions, tips and tricks, etc. You 
might find this manual easier to read and refer to in printed form.

Prices for Registering MergeFax 2.1

This version of MergeFax 2.1 is distributed as "shareware" or "try-it-before-you-buy-it" 
software. Unregistered evaluation copies can be shared and distributed freely. 
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However, you may not share the registration key, which is supplied to licensed users 
only. If you choose to continue using the program and register, that registration key 
may be used only by the licensee specified in the original order for the license. 
Licenses are not transferable and may not be modified.

a) SINGLE LICENSE for the use of MergeFax 2.1:
A single license permits you to use one copy of the MergeFax software on a 
single computer.

Single License Price
1 computer $55

b) SITE LICENSE for the use of MergeFax 2.1:
A site license permits you to use MergeFax on as many computers as you have 
licenses.

Site License Price
2 to 9 computers $42 each

10 to 24 computers $32 each
25 to 49 computers $26 each
50 to 99 computers $19 each

As a licensed MergeFax user, you will receive the following:

· A permanent license and set of registration numbers that will end the trial 
period and turn your evaluation copies of MergeFax into licensed versions.

· Unlimited free Technical Support via electronic mail and a 24-hour fax line.

· Special offers on future releases.

· Influence on future development. We welcome your ideas, thoughts, and 
suggestions for making MergeFax more useful. In fact, we'll add them to our
"Future Projects List" (large outlines that we use to guide a product's 
development by breaking it down into goals and sub-goals, features and 
functions, and other important information). This allows us to, not only 
remember your suggestions, but to consider them in the right place and 
time during the development process.

· Free updates, patches, and "bug fixes" with same-day notification!  Every 
time we release new updates, patches, and "bug fixes," we will send you 
written instructions explaining exactly where to go on-line in order to search for,
download, and install these latest and best-performing versions. Updates are 
free to licensed users, and one of the nicest things is that we notify you 
immediately — via electronic mail or fax — the very same day they become 
available on CompuServe and the other on-line services. This way you'll always
have the latest versions within hours after we've finished them — red-hot off 
the presses! In fact, electronic distribution is so fast and slick, you'll be running 
MergeFax's latest versions long before most SysOps have even put them up.
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Methods for Registering MergeFax 2.1

To receive a permanent license for MergeFax 2.1, open the file REGISTER.DOC and 
E-mail, Fax, or Mail the registration form to:

E-mail  :  BONZI Software
Attn: Registration Processing
CompuServe: 72053,2227
or Internet: 72053.2227@compuserve.com

Fax  :  BONZI Software
Attn: Registration Processing
396 17th Street
Paso Robles, CA  93446
Fax: 805-238-5798

Mail  :  BONZI Software
Attn: Registration Processing
396 17th Street
Paso Robles, CA  93446
U.S.A.

Note: If you have a technical question at the time of registration, please send a separate message to 
"Attn: Technical Support."

For quickest response, register electronically via E-mail. We are setup to process your 
registration, enter you into our database of licensed users, and send you your license 
and registration number(s) rapidly.

Note: Please do not send the actual file REGISTER.DOC in "binary" format. Rather, the best method is 
to copy and paste the first page into an e-mail.

For non-credit card orders, please register via regular mail with a check or money order
made payable to: BONZI Software.

Contacting Technical Support

If you have a question about MergeFax, and you cannot find the answer in the printed 
documentation, feel free to contact us at:

E-mail  :  BONZI Software
Attn: Technical Support
CompuServe: 72053,2227
or Internet: 72053.2227@compuserve.com
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Fax  :  BONZI Software
Attn: Technical Support
396 17th Street
Paso Robles, CA  93446
Fax: 805-238-5798

Mail  :  BONZI Software
Attn: Technical Support
396 17th Street
Paso Robles, CA  93446
U.S.A.

For quickest response, contact us electronically via E-mail.

Other BONZI Software products

BONZI Software also offers these other Word 6.0 add-on programs:

· FAstFax 4.2 for WinFax PRO
· FAstFax 4.1 for At Work Fax
· FAstFax 4.0 for Eclipse FAX

FAstFax 4.2 is an extremely easy and friendly interface program that allows you to fax 
from Microsoft Word for Windows 6.0 through WinFax PRO, taking full advantage of the
latest WinFax 3.0, 4.0 (and WinFax for Networks) technologies.

You can install FAstFax in minutes, and have your entire company faxing quickly and 
easily through WinFax PRO.

FAstFax allows even the most inexperienced computer users to fax confidently. There's
little or no training, because users only have to remember one keystroke, and FAstFax 
leads them through the rest.

Here's how:

1. FAstFax scans your document, finds the recipient’s name and fax number, and 
(using DDE) automatically passes them over to WinFax PRO—so you no longer 
have to keep TWO separate phonebooks. If you were tired of typing a person’s 
name and fax number TWICE—once on the document and again before you 
faxed—you will love FAstFax.

2. FAstFax shows you a thumbnail page preview of your document—so you’ll always 
fax the correct pages, and be able to check the final look and layout of your fax 
before sending it off.
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3. FAstFax automatically sets the fax driver and resets the printer driver for you—so 
you don’t have to think about driver settings again. And no more print jobs 
accidentally sent to the fax modem!

4. FAstFax allows you to "Fax & Print" with one keystroke. For example, it sets your 
fax driver, faxes your document, then re-sets your printer driver, and prints your 
document—all automatically, all with one keystroke.

5. FAstFax allows you to access the WinFax PRO send screen so you can quickly 
select File Attachments, Cover Pages, Phonebook entries, etc. You can even 
use FAstFax to quickly add a person's name and fax number to the WinFax PRO
phonebook without having to re-type it.

6. FAstFax's Date and Time Scheduling features allow you to send your faxes 
immediately or schedule them for later. This is especially useful for taking 
advantage of the cheaper phone rates late at night.

7. FAstFax also gives you a Resolution Choice feature that allows you to send "low 
resolution" or "standard" faxes—yet another way to save on long distance phone
costs. This one is great for faxing internationally—saving you money on every 
fax you deliver before crossing into that costly "second minute."

8. FAstFax's page range settings allow you to easily fax an entire document or just the 
current page—which is great for those quick 1 page faxes.

9. FAstFax also handles all of the following dialing prefixes automatically: Outside line 
access codes (for example "9"), Local area codes, Long distance access codes, 
Local long-distance access codes, and 800 prefix access codes.

10.FAstFax does all this in 2 keystrokes!

1.  Hit Alt-X and ENTER.
2.  Go get a doughnut.

You'll find FAstFax available on CompuServe and the other on-line services. To try 
FAstFax for WinFax PRO, search for and download the self-extracting file named 
FASTFA.EXE. To try FAstFax for At Work Fax, search for and download the self-
extracting file named FASTAW.EXE. To try FAstFax for Eclipse FAX, search for and 
download the self-extracting file named FASTEF.EXE.

Appendix A: Un-Installing MergeFax 2.1

If you decide after trying MergeFax 2.1 that it's not for you, you can easily remove it 
from your system. Here's how:

1. Delete the [MergeFax] section from your WIN.INI file.
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2. Delete all of the MergeFax 2.1 files that came in the self-extracting package: 
MRGFAX.EXE, MERGEFAX.DOC, MERGEFAX.DOT, MERGEFAX.BMP, 
REGISTER.DOC, VENDOR.TXT, FILE_ID.DIZ, README.1ST, SAMPLE.DOC, 
and SAMPDATA.TXT.

3. Delete the MergeFax macro from your normal.dot (global) template by hitting 
Tools>Macro>Delete. When you delete the macro, Word 6.0 will automatically 
remove it from the menu it is installed on, and free up it's Alt-M shortcut key.

4. Delete the file MERGEFAX.BMP from your Windows directory.

Thank you for trying MergeFax 2.1!

* * * * * * * * * * End of MergeFax User’s Guide * * * * * * * * * *

19



* * * * * License Agreement * * * * *

You are encouraged to use this program for 7 sessions prior to obtaining a permanent license. You may 
share the files MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP with anyone you choose as 
long as you do not change them. You may not share the registration key, which is supplied to licensed 
users only. If you choose to continue using the program and register, that registration key may be used 
only by the licensee specified in the original order for the license. Licenses are not transferable and may 
not be modified. A single License permits you to use one copy of the MergeFax software on any single 
computer, provided the MergeFax software is in use on only one computer at any time. If you have 
multiple Licenses for MergeFax, then at any time you may have as many copies of MergeFax in use as 
you have Licenses.

It is your responsibility to determine if the program will work reliably on your equipment and for your 
particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO 
THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER 
BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL 
RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow 
the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may 
not apply to you.

This agreement shall be governed by the laws of the State of California and shall inure to the benefit of 
BONZI Software and any successors, administrators, heirs and assigns. Any action or proceeding 
brought by either party against the other arising out of or related to this agreement shall be brought only 
in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, 
California. The parties hereby consent to in personam jurisdiction of said courts.

* * * * * Acknowlegements - Trademarks * * * * *
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